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Temat: Fotogrametryczne opracowanie elementów mapy zasadniczej na 

podstawie stereogramu zdjęć lotniczych. 

Część 2: Pomiar danych do NMT na stereogramie zdjęć lotniczych  
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1. WSTĘP TEORETYCZNY 

Po wykonaniu orientacji bezwzględnej stereogram jest gotowy do dalszych pomiarów - etapu, który 

można ogólnie określić mianem generowania produktów kartograficznych. Przebieg typowej technologii 

fotogrametrycznej został pokazany na powyższym schemacie.  

Aby wygenerować ortoobraz (wykonać ortorektyfikacji zdjęcia) konieczne jest posiadanie 

numerycznego modelu terenu oraz obrazu (zdjęcia) o znanych elementach orientacji wewnętrznej oraz 

zewnętrznej. Zakładając projekt fotogrametryczny wprowadzono do niego informację o elementach 

orientacji wewnętrznej zdjęć. Po wykonaniu orientacji bezwzględnej wyznaczono elementy orientacji 

zewnętrznej zdjęć, które zostały zapisane w projekcie. Pozostaje pomierzyć dane oraz wygenerować 

numeryczny model terenu (NMT). 

Budowa numerycznego modelu terenu składa się z dwóch etapów. Pierwszy to pozyskanie (pomiar) 

danych a drugi to generowanie na ich podstawie właściwego NMT. 

 Fotogrametryczny pomiar danych do numerycznego modelu terenu polega na opisie geometrii 

powierzchni topograficznej punktami oraz liniami o określonym położeniu 3D, z wykorzystaniem techniki 

pomiaru stereoskopowego. Punkty te mogą tworzyć zbiór punktów rozproszonych lub być pomierzone 

w postaci quasi-regularnej siatki. Linie wektorowe (tzw. breakline'y) opisują linie szkieletowe terenu 

(linie grzbietowe, ciekowe), linie nieciągłości powierzchni terenu (podnóże i szczyt skarpy), obszary 

wyłączeń (np. powierzchnie pokryte wodą). Na podstawie pomierzonych punktów i linii wektorowych 

generowany jest numeryczny model terenu. NMT najczęściej jest tworzony w postaci regularnej siatki 

kwadratów lub prostokątów (GRID) albo w postaci nieregularnej siatki trójkątów (TIN).  

Model w postaci regularnej (GRID) określany jest przez zdefiniowanie na danym obszarze regularnej 

siatki kwadratów lub prostokątów o przyjętym rozmiarze ich boków. Na podstawie pomierzonych 

punktów i linii wektorowych (breakline'y) interpolowane są wysokości wierzchołków tej zdefiniowanej 

siatki. Wysokość dowolnego punktu interpoluje się później z NMT na podstawie wysokości czterech 

wierzchołków kwadratu lub prostokąta, w którym znajduje się punkt o poszukiwanej wysokości. 

Powierzchnia terenu jest, zatem reprezentowana przez regularną siatkę punktów o wysokościach 

wyinterpolowanych na podstawie danych pomiarowych, a te dane pomiarowe w modelu nie pozostają.  

Model w postaci nieregularnej (TIN) powstaje przez połączenie pomierzonych punktów oraz węzłów 

linii wektorowych w sieć nieregularnych trójkątów. Tak utworzona sieć elementarnych płaskich trójkątów 

jest numeryczną reprezentacją kształtu powierzchni terenu. Wysokość dowolnego punktu wyznaczana 

jest później z NMT z trójkąta, na którym leży wyznaczany punkt przy założeniu, że leży on na jego płaskiej 

powierzchni.  W modelu TIN pomierzone dane (punkty i węzły linii) pozostają w NMT jako wierzchołki 

(a odcinki linii wektorowych jako boki) trójkątów, ale w procesie generowania NMT mają zdefiniowaną 

topologię (sąsiedztwo).  

Prawidłowo zbudowany numeryczny model terenu powinien umożliwić interpolację wysokości 

dowolnego punktu z założoną uprzednio dokładnością.  
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W czasie opisywanych zajęć tworzony będzie NMT w postaci nieregularnej siatki trójkątów. 

Prawidłowo zbudowany model w postaci TIN charakteryzuje się tym, że w zakresie określonej 

dokładności każdy z wygenerowanych trójkątów powinien przylegać do terenu. Osiąga się to po 

spełnieniu dwóch warunków: 

• pomiar wysokościowy musi być dokładny - kursor w momencie rejestracji położenia punktu lub 

wierzchołka linii załamania musi przyjąć położenie na terenie z określoną dokładnością 

• sytuacyjne położenie punktów rozproszonych oraz linii załamania musi być dostosowane do 

szczegółów topografii terenu: np. jeśli narysowane są dwie krawędzie rowu, musi być 

narysowane jego dno, w przeciwnym razie, po wygenerowaniu siatki trójkątów geometria tego 

rowu nie będzie miała reprezentacji w NMT. 

Typowym błędem pomiaru danych do numerycznego modelu terenu jest takie rozmieszczenie 

punktów, że powstają tzw. przewieszenia. Może się to zdarzyć przykładowo przy pomiarze mostu, jeżeli 

zostały pomierzone elementy na moście i pod nim. Wówczas w momencie ortorektyfikacji powstają 

artefakty. Generalna zasada jest następująca: linie załamania nie mogą być wichrowate - nie mogą się 

krzyżować na różnych wysokościach. 

 

2. PRZYGOTOWANIE DANYCH, WYŚWIETLENIE MODELU STEREOSKOPOWEGO 

Do pomiaru numerycznego modelu terenu zostanie użyta aplikacja DEPHOS Mapper Stereo. 

Skrótem DEPHOS41103virtual.exe, z menu rozwijalnego Start należy uruchomić program DEPHOS 

Mapper Stereo. 

Pojawia się okno wyboru projektu oraz modelu do wyświetlenia: 

 

 
 

Należy wskazać ścieżkę dostępu do pliku z własnym projektem z wykonaną orientacją bezwzględną 

(D:\Stud\GiK\TiF2\Nazwisko_prowadzącego\Nazwisko_studenta\temat_1\....), wybrać model 

i nacisnąć OK. 
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Pokażą się dwa zdjęcia stereogramu, które można obserwować stereoskopowo przy pomocy 

okularów. Obraz należy obserwować prostopadle do płaszczyzny ekranu (frontalnie). 

 

Może się wydarzyć, że wygląd modelu wskazuje włączenie się widoku pseudoskopowego. Wówczas 

elementy wklęsłe wydają się wypukłe i na odwrót. Zdarza się to sporadycznie na skutek błędów 

sterowników kart graficznych. W takim przypadku należy przejść klawiszem ESC do linii komend, która 

znajduje sie w lewym dolnym rogu, i wpisać polecenie pstereo=not, a następnie zatwierdzić klawiszem 

Enter: 

 

 
 

Do przybliżonego poruszania się po modelu służą następujące kombinacje klawiszy: 

 

• Znaczne zmiany powiększenia wykonuje się kręcąc kółkiem scroll myszki przy wciśniętym Ctrl na 

klawiaturze. 

• Przesuwanie modelu wykonuje się przy jednoczesnym wciśnięciu Shift i lewego klawisza myszki. 

 

DEPHOS Mapper Stereo może pracować w trybie MOUSE, w którym kursor przesuwa się na tle 

modelu lub w trybie ROAM, w którym model przesuwa się pod kursorem znajdującym się cały czas 

w środku okna widokowego. 

Przełączanie tych trybów odbywa się przez wybór odpowiedniej kombinacji przycisków 

manipulatora lub, gdy dysponujemy wyłącznie myszką, poprzez wpisanie w wierszu poleceń komendy 

roam=not i zatwierdzeniu (Enter): 

 
 

Do linii komend, która znajduje się w lewym dolnym rogu, przechodzi się klawiszem ESC. 

Pomiar najwygodniej wykonuje się w trybie ROAM. 

Odpowiednie powiększenie można ustawić albo zgrubnie, jak podano powyżej lub używając jednego 

z 3 ustawień standardowych poprzez wpisanie w linii komend setzoom=next. 
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Współczynniki powiększenia standardowego można zmienić w opcjach programu w menu głównym: 

Options->Options w pozycji Zoom 1, Zoom 2 lub Zoom3: 

 

 
 

Im większy współczynnik, tym większe powiększenie. Aby można było wykonać dokładny pomiar 

współczynnik powiększenia powinien wynosić, co najmniej 700. Użycie komendy setzoom=next 

powoduje przestawianie powiększenia cyklicznie. 

 

 

3. ORGANIZACJA ŚRODOWISKA PRACY. 

 

Zanim przystąpimy do właściwych pomiarów powinniśmy ustalić elementy, które będą rysowane 

oraz określić ich atrybuty. 

Do tego służy plik sidebar. Jest to plik zawierający komendy rysunkowe oraz zdefiniowane atrybuty. 

W naszym przypadku komendy będą dotyczyły pomiaru punktów oraz linii wektorowych, a plik nazywa 

się sidebar_AGH_NMT.txt i jest w naszym katalogu. 

Należy wskazać plik sidebar_AGH_NMT.txt z menu główego Customize->Sidebar oraz go wyświetlić 

na ekranie zaznaczając w menu głównym->Customize-Toolbars, zakładka Tool Windows: 
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Wyświetlony sidebar w dodatkowym oknie programu wygląda następująco: 

 

 
 

W zakładce Toolbars okna Customize należy nacisnąć klawisz Hide All i zaznaczyć do pokazania 4 paski 

narzędzi jak poniżej: 
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4. POMIAR PUNKTÓW W SIATCE QUASI-REGULARNEJ  

 

Na początku otwieramy plik wektorowy 50mOK.det (File->Open) z pomierzoną siatką o oczku około 

50m i zapisujemy go wybierając z menu głównego: 

File->Save As i podajemy ścieżkę do własnego katalogu i nazywamy plik NMT_NazwiskoStudenta. 

 

Pierwszym etapem będzie osadzanie znaczka w siatce regularnej. Na tym etapie należy zwrócić 

szczególną uwagę na prawidłowe położenie wysokościowe mierzonych punktów. 

Pomniejszamy obraz (Ctrl+scroll myszki), żeby zobaczyć cały obszar wskazany przez prowadzącego, 

który ma podlegać pomiarowi NMT. 

Ustawiamy kursor powyżej średniej wysokości obszaru. 

Wybieramy pozycję z sidebara Definiowanie siatki. 

Pojawia się okno Define Grid: 

 
w którym ustawiamy wielkość skoku siatki Col spacing oraz Row spacing na 10 m. 

Zaznaczamy myszką na ekranie prostokąt pokrywający obszar wskazany przez prowadzącego. 

Pojawia się seledynowa siatka punktów 2D, które reprezentują położenie XY punktów, które w kolejnym 

kroku będą mierzone wysokościowo. 

 

W przypadku błędnego zdefiniowania siatki należy użyć ikony Delete grid z toolbaru DTM i wybrać 

według daty i godziny siatkę, którą chcemy skasować. 

 

Wybieramy z sidebara: 

Rysowanie siatki i w oknie Select grid: 
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wybieramy dwa razy klikając definiowaną siatkę (jej nazwa to data i godzina utworzenia) 

i w następnym okienku Grid: 

 
zaznaczamy opcję Not edited i naciskamy klawisz Find first. 

Znaczek pomiarowy przestawiany jest do pierwszego punktu siatki 2D. Należy kółkiem myszki 

doprowadzić wysokość kursora do właściwej, lokalnej wysokości terenu, a następnie nacisnąć lewy 

klawisz myszy. Program automatycznie zapisze punkt i przejdzie do przybliżonego położenia kolejnego 

punktu siatki 2D utrzymując wysokość ustawioną przy pomiarze poprzedniego punktu. Nie powinno się 

zmieniać położenia XY. W kilku przypadkach można przesunąć sytuacyjnie punkt w dogodne miejsce lub 

zrezygnować z pomiaru klikając prawym klawiszem myszy: 

• gdy przybliżone położenie punkty wypada nie na terenie, ale na elemencie, którego wysokości 

nie reprezentuje wysokości terenu (np. dach budynku, drzewo), 

• gdy przybliżone położenie punktu wypada w miejscu trudnym do pomiaru, a tuż obok znajduje 

się znacznie lepsze miejsce 

• dany obszar nie podlega pomiarowi (np. tafla wody w rzece), 

•  w sytuacji, gdy punkt pokrywa się z pomierzonym już punktem siatki wczytanej z pliku 

50mOK.det. 

Przy sytuacyjnym przesuwaniu znaczka nie można odsunąć się od położenia przybliżonego o więcej 

niż ustawiona w okienku GRID wartość R (w naszym przypadku R = 5m). Po odsunięciu znaczka 

pomiarowego na większą odległość niż R na obrazie pojawi się różowa kropeczka pokazująca granicę 

obszaru o promieniu R. Jeżeli w odległości ≤R od punktu przybliżonego nie jest możliwe osadzenie 

znaczka na terenie (np. jest to dach dużego budynku lub są to drzewa) należy ten punkt pominąć (prawy 

klawisz myszy). 

Powrót do pomiaru punktów pominiętych odbywa się poprzez wybór z sidebara Rysowanie siatki, 

wskazanie tej samej siatki i zaznaczeniem w oknie Grid opcji Skipped. 

 

Jeśli dokończymy pomiar siatki, pojawi się komunikat: 

 

 

 

 

W trakcie pomiaru zaleca się, aby co jakiś czas zapisać plik *.det (File-Save lub ikona dyskietki). 
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5. KONTROLA POMIARU PUNKTÓW DO NMT PO POMIARZE SIATKI QUASI-REGULARNEJ. 

 

Po zakończeniu pomiaru punktów quasi-regularnej siatki można wykonać próbne generowanie NMT 

w postaci nieregularnej siatki trójkątów (TIN). Tworzenie trójkątów odbywa się narzędziem 

Triangulation. Z menu głównego wybieramy Tools->Triangulation, ustawiamy opcje jak poniżej 

i rozwijamy okno opcji strzałką w dół: 

 

 
W dodatkowym polu wskazujemy plik triang_AGH.txt w naszym katalogu: 

 

 
 

który zawiera informację, które elementy naszego pliku DET algorytm generujący siatkę trójkątów 

powinien brać pod uwagę. Plik ten tak steruje generowaniem siatki TIN, że występujące w pliku DET 

elementy posiadające odmienne atrybuty, nie będą brane pod uwagę przy tworzeniu numerycznego 

modelu terenu (np. obrysy dachów). W naszym przypadku nie ma to znaczenia. Klawisz Triangulate: 
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służy do wygenerowania siatki trójkątów. Okno Triangulation może być cały czas otwarte i po 

kolejnych etapach pomiarów (np. poprawkach) można ponownie sprawdzać, jak wygląda siatka 

trójkątów. Zgodnie z podaną zasadą, trójkąty (ich boki) powinny leżeć na terenie - nie przecinać go, ani 

nad nim nie wisieć. 

Jeśli chcemy, żeby siatka zniknęła, wystarczy odznaczyć opcję Triangles w oknie Triangulate 

i nacisnąć klawisz Triangulate: 

 
 

Analiza siatki trójkątów może prowadzić do trzech wniosków: 

• wszystko jest prawidłowo 

• pomierzone punkty mają złą wysokość 

• brakuje punktów rozproszonych 

• brakuje linii załamań terenu 

 

Poprawa źle pomierzonych punktów polega na skasowaniu punktu i pomiarze jeszcze raz, 

najwygodniej jako punktu rozproszonego. 

Do skasowania potrzebujemy narzędzi do zaznaczenia i kasowania. Zaznaczyć należy strzałką z paska 

Edit: 
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i wskazać punkt do skasowania. 

Następnie wybrać Delete z paska Manipulate element: 

 

i zatwierdzić klikając na okno widokowe. 

 

 

6. POMIAR PUNKTÓW ROZPROSZONYCH 

 

Pomiar punktów rozproszonych odbywa się po wybraniu z sidebara komendy Pikieta siatki. Należy 

wskazać odpowiednie miejsce pod względem sytuacyjnym i wysokościowym, osadzić na terenie znaczek 

pomiarowy i zatwierdzić położenie lewym klawiszem. Zaleca się kontrolne generowanie siatki trójkątów. 

 

 

7. POMIAR LINII ZAŁAMANIA TERENU. 

 

Linie załamania mierzy się po wybraniu z sidebara komendy Breakline. Zasadą pomiaru jest 

ustawienie kursora (a zatem każdego kolejnego punktu załamania linii) na wysokości terenu, 

w sensownym sytuacyjnie miejscu (pod względem topograficznym). Długości odcinków pomiędzy 

kolejnymi wierzchołkami powinny być tak dobrane, aby linie nie zagłębiały się, ani nie wisiały nad 

terenem. Po pomiarze możliwa jest edycja wierzchołków (dodawanie, kasowanie, przesuwanie), która 

dostępna jest na pasku Modify vertex. 

W trakcie pomiaru zaleca się kontrolne generowanie siatki trójkątów. 

 

Po zakończeniu zapisujemy plik z menu głównego File->Save oraz opuszczamy program File-Exit 

potwierdzając wolę zapisu pliku: 

 

 
 

Na końcu pomiaru, należy zostawić punkty pochodzące z pierwotnego pliku 50mOK.det. 

Na końcu opuszczamy Mapper Stereo zapisując zmiany w pliku DET. 

 

 


